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SYSTEM DESIGN
This chart shows a proper technical setup in a Virtual Production environment:



1.1 INSTALLATION OF UNREAL 4.27.2
1) What you need:

Unreal Engine 4.27.2 on Master and Clients

pixera_unreal_engine_interop_4.27.2_P.exe Installer

PIXERA_Connect_1.9_4.27_P.zip Plugin

.NET 4.8 SDK
(https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net48-developer-pack-offline-installer)

If you want to pack your project:

Visual Studio 2019 (https://visualstudio.microsoft.com/de/downloads/ Community License is fine)

Full Unreal Engine form AV Stumpfl on request (Unreal_Engine_4-27_O.zip)

2) Download and install Epic Games launcher

3) Login and install unreal Engine
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5) Install pixera_unreal_engine_interop_4.27.2_P.exe Installer

Please make sure to select the right directory

6) Install .NET

Optiona for packed projects:

7) Unzip the Engine in your preferred folder. 

8) Install Visual Studio including following Options (only necessery if you want to pack a project):

Add Game development with C++ (under Workloads) and following options: 

C++ profiling tools

C++ AdressSanitizer

Windows 10 SDK (10.0.18362 or newer)

Unreal Engine Installer



1.2 CREATE A PROJECT IN UE4EDITOR

Open UE4Editor.exe (Unreal_Engine_4-2D_C\Engine\Windows\Binaries\Win64\)

NOTE: Stay patient – first startup will take some minutes…

Select from New Project Categories „Film, Television, and Live Events”



Click next, select the „nDisplay“ template and click next again.

Select your location and click on „Create Project“.

The first initialization will take some minutes…



1.3 SYSTEM PREPARATION

1.3.1 PIXERA - UNREAL PLUGIN FOR OBJECT MOVEMENT

To be able to move objects of the Unreal scene directly in PIXERA you have to copy the PIXERA_Connect plugin 
to its correct directory:

Create a folder called „Plugins“ next to your project file (D:\Unreal_Projects\Pool\Plugins)
Extract PIXERA_Connect_1.9_4.27_P.zip directly (without subfolders) to created Plugins folder.



1.3.2 PACKAGE UNREAL PROJECT FOR PIXERA

To package the project in unreal click on File→ Package Project→Windows (64-bit) and select the directory
where you want to pack it. (i.e. D:\Unreal_Projects\Pool_export)



1.3.3 UNREAL PROJECT IN DASH GAME MODE

To run your Unreal project in dash game mode there are no further steps in Unreal necessary.
Just import your project, assign your screens, create nDisplay config, distribute to clients and copy 
RXInterop.dll. Then you are already able to run you project.



1.3.4 UNREAL PROJECT IN MULTIUSER MODE

In Unreal the multi-user plugin has to be enabled.

After saving an restarting your Unreal scene, navigate to „Project Settings“ (Edit→ Project Settings..),
navigate to „Pugins“→ „Multi-User Editing“.
“Enable Multi-User Toolbar Button“ and “Auto Connect“ have to be enabled.
Further please enter the Windows computer name of your Unrel Server in “Default Server URL“ and assign a 
name for “Default Session Name“.



A new window pops up, afterwards close Unreal again.

Now you can import the project to PIXERA - please find instruction in the paragraph Import to PIXERA

Save your project and re-open it.
Click on the arrow next to „Join“ in the toolbar and select Launch a local Multi-User server.



If you want to control position out of PIXERA, set it movable.

1.4 UNREAL TEXTURE SHARING
Add a plane (can be another shape as well) to your project and place it wherever you like.



Add a render Target by clicking on Add/Import and navigate to Material & Textures – Render Target.

Rename it if you want.

Drag and drop the created render target to your plane. A new material will be created automatically.



Open Blueprints - Level Blueprint.

Double click on the created render target to adjust the resolution - Save.



Right click in the event graph and add Setup Input Texture.

Add Event Tick from left hand site to your Event Graph (workspace in the center).



NOTE: The Input ID in “Setup input Texture” referes to sampler ID in PIXERA’s PUX file.

Select your created render target and Save it

Connect those two.



Drag and drop the material into the material in the pane properties on the right:



Double-click on the material, select the Texture Sample and change the Sampler type to Linear Color. 
Save afterwards. If you want the plane to emit color as well, you can link RGB output of Texture
Sample  to Emissive Color input of the material as well.



If you want to have two targets to share, repeat the steps and connect them as shown below:

After importing your Unreal project in PIXERA you have to add a Display with the resolution of 
your created texture in Unreal. 

• Please use a seperate Screen Group for this Display.

• Further you have to add an Unreal Output Stream for each client you want to display the 
shared texture. 

• All those outputs have to be assigned to the newly added Display and the resolutions have to be the same 
in Pixera (Display resolution and Unreal Output resolution) and Unreal Texture.

• Index of Input Texture in Unreal Engine refers to the Input ID in Unreal.

• Transfer Characteristics have to be set to Linear.



After importing the Unreal asset Pixera automatically streams the content of the Display into Unreal.

Just assign a layer to the display with the assigned "Unreal Output Stream" and start to add content onto it. 
The whole compositing of this display is then visible on the shared texture in Unreal
NOTE: In this example, the layer used was named "Sidecar" - but it is a standard layer, no special naming 
conventions are needed.

• For set extension or foreground you can add a additional Latency to the specific output in the Inspector 
by selecting the Display in Mapping Tab (change selection mode to be able to select a Display).



2. VIRTUAL PRODUCTION SETUP IN PIXERA

2.1 FOREWORD
Virtual Production features are available for official PIXERA hardware as well as the Server license. It is not
available for the Director and Player license.

By using the newest PIXERA Version, it is possible to utilize Unreal Engine, Unity as well as Notch in PIXERA for
virtual production setups and other projects that would benefit from these powerful tools.

This workflow Guide focuses on the technical setup of Unreal Engine in PIXERA. It is a step by step guide. As long 
as you follow everything, you should be able to get a test setup running. 

Here is a list of features we were able to test and can confirm they are working properly:

Unreal Engine Preview

Unreal Engine Playout scaled over 3 servers in sync 

Unity Preview

Unity Playout (currently we do not have any sync mechanism implemented for Unity. We are investing further
R&D resources and will post regular updates if sync is possible, as there might be a chance)

Notch Preview & Playout (Notch currently only supports one Viewport Render, therefore realising a setup is
tricky and requires utilization of Camera and back projection)

Stage Precision direct API and SPNet tracking integration with the Studio Camera feature in PIXERA. 
Tracking with Vive, OptiTrack, FreeD, Antilatancy, Sytpe, Mo-Sys, is tested so far

The following applications are necessary for a proper Unreal Engine setup in PIXERA:

Pool_texture_1.5.exe (or any other packed Unreal project) 

PIXERA 1.8.45 or later

Please not that it is not necessary anymore to launch nDisplay Listener or Launcher and to copy Rxinterop.dll 
manually.



2.2 XR STAGE IN PIXERA
The steps are explained on a simple setup.
In this example we use for the left LED a ROE DM2.6 in a 6x5 panel array, the right LED is a ROE DM2.6 as well in a 
8x5 array and for the floor we use a ROE BM4 in a 7x5 array.

For a proper setup, go ahead and connect physical outputs to your Screens/Displays/LEDs.
Though for test purposes you don’t have to have a physical output assigned to your setup. It is possible to only
work from within the preview. For tests scenarios this is totally sufficient.

In case you want to play out on real outputs, you can find the output configuration in the Mapping tab. This setup 
looks different on each computer, as it depends on the system you are currently using. PIXERA will display the 
graphics card outputs of all your systems in the network. Here is an example of a possible network setup:

(make sure to have the selector on the top right set to „Screens“ instead of projectors, otherwise you won’t be
able to select and assign outputs to your displays)



2.3 IMPORTING UNREAL PROJECTS
Unreal has to be imported by using the new VR/AR button in the interface:

We do offer the same demo scene for download on our website here:
https://pixera.one/de/downloads/

There are three options how to import your Unreal project
• Packed project (.exe File packed in Unreal)
• Dash Game (.uproject file)
• Multi-User (.uproject with Multi-User Plugin)

In inspector you have to select the corresponding mode to be able to lauch it the right way. When using .uproject
file you have to set the path for UE4Editor in “EditorPath“ as well. This can be set as initial value in PIXER settings
as well. Further please note that you can switch between Unreal Engine 4.26 and 4.27.

Once imported, drag and drop the scene on the empty timeline. If you already have regular layers in use, 
please be cautious. We implemented a new layer type for 3D engine applications:

https://pixera.one/de/downloads/


By simply dragging – and – dropping Unreal on an empty timeline, PIXERA will automatically create the correct 
Compositing Layer for you:



2.4 SCREEN PRESENCE AND NDISPLAY CONFIG FILE
After assigning the scene to a layer, the so called Screen Presence has to be edited. By right-clicking on the layer 
head the drop down menu can be accessed.

Inside the Screengroup, settings change from 2D to 3D:

Preview Resolution Factor in inspecor allows for lowering the resolution within the preview. We strongly suggest to 
turn down this value for the Preview machine. The value is displayed in percentages. 1.00 equals 100% whereas
0.50 equals 50%.
With Outer Frustum Resolution Factor you can lower the resolution of you LED output to mimimize system load.



After finishing those steps you can distribute your project to your clients with Distribute Project to Clients button, 
and createa nDisplay config file by pressing Create button at the bottom in inspector. In Edit config file you can 
select for which display should be part of the nDisplay configuration. Please don‘t forget to distribute
RxInterop.dll after installing a new Version of PIXERA or importing a new packed project.

PIXERA will automatically generate a separate config file for the Render-Nodes and one for the Preview.

After these steps, the config files should have been created next to your Unreal project file (either *.exe or
*.uproject)

NOTE: Use Distribute Proejct to clients to spread your project. The Unreal project is copied to the exact same file 
path as it is on your master. So please make sure that the same drive letter is available on your clients.

NOTE: Please remember, you should refresh whenever you change something output screen or hardware related

It is of course also possible to open the config files, in order to get a deeper understanding, although it is not
necessary.

The last step is to run the project.
Therefore you have to select which instances of Unreal 
you want to launch. You can chosse between:

Preview (for previewing in your PIXERA Workspace) 

Local (if outputs are running on your Director machine) 

Clients

PIXERA will automaticall lauch nDisplay in the background and run your scene on the selected instances wehn 
clicking Run button.

NOTE: If changes to the system setup have been made, you first have to Kill the scene, crate a new config
and Run your scene again.



The complete Unreal scene is rendered inside PIXERA. You can press “D” on the keyboard or dive in via the “dive 
in” button in the compositing tab, in order to get into the 3D scene:

The displays act as viewports looking into the Unreal scene. Changing the position of the screen in PIXERA 
changes the viewport position in Unreal as well. In this example, I moved the screens up on the X axis as well as 
adding rotation:

In the „outer compositing“ which represents the „real setup“ you can now see how the Unreal sceene is rendered 
to Displays



2.5 MOVING OBJECTS IN PIXERA

If the used scene was created with our Unreal Plugin, you also have the possibillity to manipulate objects in Unreal 
via PIXERA.
In inspector you can find a list of all avialable items. You can either manipulate them in inspecor itself or you can
add them to the timeline by right clicking an object. Further you can multiselect multiple object and add them to
the timeline as group. This might be interesting e.g. when changing multiple lights simultanously.

After a new layer is added to the timeline crate a new object by doubleclicking in the layer. Then you can add 
keyframes to manipulate the object in your timeline.



3. STUDIO CAMERA SETUP
The Studio Camera is needed if you are using a Camera and want to either back project the camera frustum to
your LED Wall or control entire Perspective of your LED Wall, if you want to use foreground in your live input signal
or for using set extension. Camera parameters can be manipulated in Realtime via tracking System.

Navigate to Screens Tab – Cameras and drag & drop your Studio Camera to your workspace.

Select your camera in workspace and adjust the properties in Inspector.

Please note, that you have to edit the screen presence settings of your layer after adding or changing parameters 
of your Studio Camera.



3.1 STUDIO 
CAMERA SETTINGS

Screens Associated with Camera:

Select the Screen where you want to project your 
camera frustum Background

Background:

Activate Background and Project on associated
Screens to be able to project your frustum to the
screens.

Use Overscan to increase the size of your inner
frustum

Activate Control Perspective Position of 
associated Screens to link the perspective of the 
screens to the camera position. This needs to be 
done to have realistic reflections in real world for 
camera movements.

Live Input:

Select and activate the Live Input of your camera 
on your client that is used for mixing Real and 
virtual world. Delay represents Delay of your
tracking system.

Foreground:

Activate Foreground to mix Camera image and 
virtual foreground together.

Adjust the delay of your camera to synchronize 
for and background animation.

Near and Far plane must be set separately for the 
foreground to adjust the depth visibility.

Activate Discard Background to make your 
Unreal scene transparent behind the far plane to 
be able to see the Live Input.

No output must be set here unless you want to 
route just the foreground on a separate output.



Activate to extend your camera view beyond the 
physical LED wall. This means that you can see the 
virtual world in your camera image beyond the 
boundaries of your physical LED wall.

Update Screen Mask must be applied after ma-
king changes of physical position and size of your
screens in PIXERA.

Delay should be the same as in foreground settings.

Mask Softness can be applied to make a softed 
transition from physical live video to virtual world at 
the edges.

No output must be set here unless you want to 
route just the virtual set extension on a separate 
output.

Output for Live Input and VR:

Select the output where you want the route the 
mixed signal of live input, foreground, and virtual set 
extension.

Tracking:

Activate Use with Direct API Input to get maximum 
performance for you tracking. Click Reload Engine 
IDs after any changes you have done in the Came-
ra or general setup settings to make sure, that the 
tacking input is passed to the right objects.

Please note, that most of the Camera parameters 
are driven by the tracking system. To adjust them 
manually, use Pause Direct API Input checkbox to 
temporary disable tracking input and adjust values 
manually.

Lens Parameters:

Those parameters can either be set manually or 
automatically by your tracking system.

Transformation:
Those values can be adjusted for manual positioning 
of your camera.

After all settings are done, please refresh your nDi-
splay configuration.
Your Studio Camera frustum should now follow your 
manual or tracked position.

3.2 VIRTUAL SET EXTENSION



AV Stumpfl GmbH I Mitterweg 46 I 4702 Wallern an der Trattnach I Austria I AVstumpfl@AVstumpfl.com 
www.PIXERA.one I tel.: +43 (0) 7249 / 42811 I fax: +43 (0) 7249 / 42811-4

2022-05 | We reserve the right to make modifications in the interest of technical progress.

After setting up your Camera ,Screen presence, generating config files, and running your project you can see the
Studio Camera with three planes in your preview and if activated on your output.

The plane next to your Camera represents the foreground. 

The plane in the middle is your Live Input Plane.

The 3rd plane is for background that is projected to your assoiciated screens.

On your assigned render output live input, forground and set extenseion are rendered togehter to get one 
combined image.

mailto:AVstumpfl@AVstumpfl.com
http://www.pixera.one/
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